Nasri Messarra

FLSH - USJ
MS Project
Notes et Aide Mémoire
Project Stages:
1- Initiation: kickoff, introduction.

i

Strategy: a plan of action or policy designed to achieve a major or overall aim

Analysis: what to do to meet our business needs (the process of separating
something into its constituent elements).

Design and Build: how we will do it and how it will be carried out.
Implementation: installation, hand over, closure.

¢

o

‘ Analysis | | Design ‘I
Your product does what the client expects, it has good design, with

small number of bugs
Analysis

You do not know what the client expects, the design emphasizes the wrong
expectations, and the product is riddled with bugs

Implementation ,

Design J [ Implementation

} Analysis —I Desigﬂ Implementation

You know most of what the client wants, but the design does not support the need of
the analysis and the product is riddled with bugs

| Analysis —l 1 Design I | Implementation I

You know what the client needs, but your design does not implement it and your
implementation is overcompensating fo fry fo fix it

| Design | L Implementation I

You have no idea what the client wants, the design is overly complicated for the
functionality you will provide, and your implementation is trying fo

overcompensate for the problems
[ Analysis 7 Design r lmplementaﬁon"

You have a good idea of what the client wants, the design is overly complicated for the
needs analyzed, and the implementation is not solid enough

I Analysis

re 1-1 Different doses of analysis, design, and implementation
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Cost evaluation for medium size projects (around 9 months):
1- Initiation: add 100%.
2- Strategy: add 50%.
3- Analysis: add 25%.
4- Design: add 10%.

Project

E— Activity

e Activity

A task should be between 1 and 10 days effort, otherwise break it into subtasks.

Changing task layout (rollup) to show subtasks separation when the summary is not
expanded: format > layout > always rollup & X hide rollup

Outline numbering (1, 1.1, 1.2, etc.): Tools > options > view > show outline number

Deadline date indicator: double click task > advanced tab > deadline date

Split task: select task, click the split task button on the toolbar ==+ == (or edit >
split task)

Working with calendars:
- standard calendar: tools > change working time
- create a new base calendar: tools > change working time > create new base
calendar, e.g. “night workers”. Make a copy of “standard. These calendars can
be assigned later on to resources.
- Assign calendar to project: tools > project information > calendar
- Changing calendar for a task > 2x click on the task > advanced > calendar

Constraints:
As soon as possible
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As late as possible
Finish no earlier than
Start no earlier than
Finish no later than
Start no later than

2- Resources

Use the resource sheet to add resources. 2 types work and material

Double click for advanced features like availability, resource calendar, etc.

3 types of rates: standard, overtime and per use (location of a facility, fixed fee, etc.)
You can attach notes to a resource

Assign a resource for a task:
2x click on a task and go to resources or click on the resources icon

If you add more than 1 resource for a task the duration is automatically reduced. Use
the “smart tag” to keep the duration as it is.

Click on the graph button in the assign resources dialogue to see if a resource is
overloaded. Note that the resources are shown in red in the resource table when
working hours are exceeded.

Choose tools > level resources. This will reschedule task to avoid having people
working overtime.

A resource can have both a cost per use and a standard and overtime rates.
Use table > entry > cost to view cost per task.

If a resource’s cost changes over time, double click on the resource and use the costs
tab to add more lines, e.g. 1/1/2007, $22/hr, etc.

You can also use different rates for one person (A, B, C...).
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Les Ressources

Définir les ressources:

Les ressources humaines et matérielles sont mélangées dans Project. Pour y accéder,
faire right click sur la bande du « gantt chart » et choisir « resource sheet ».

Calendar

Gantt Chart
MNetwark Diagram
Task Usage
Tracking Gantt
Resource Graph

Resource Sheet

Resource Usage

More Views. ..

View Bar

Considérer le tableau suivant :

a Resource MName Type Material Lakbel | Initials Groug Max. Units | Std. Rate Ot Rate Costllze  Accrue At |Base Calendar
Pasti M Wiork M Admins 100% $S0.004r $120.00Mr $0.00 Prorated Stanckard
2 Ouwriers Wiork o] Chiantier 1,000%  F100.0008vk F0.00Mr $0.00 Prorated 24 Hours
3 Compresseur Material tonne C Materiel $2,000.00 $500.00 Prorated

Nasri M. est de type « work », c’est-a-dire Ressources Humaines ou paye sur base de
temps. 1l fait partie du groupe «admins » et travaille a plein temps (100%). S’il
travaillait & mi-temps, on aurait pu, soit réduire les 100% en 50% ou changer le
calendrier rattaché a cette personne. Il touche $50 par heure et $120 dans le cas
d’heures supplémentaires. 1l n’y a pas de codt a I’utilisation (cost/use). Le cost/use
peut étre utile dans le cas de frais de déplacement (un consultant qui vient de
I’étranger, dans ce cas, on comptera par exemple $1,000 en frais d’avion) par exemple
ou de location de matériel (un musicien qui travaille et fait payer la location de son
équipement en méme temps).

Les ouvriers touchent $100/wk ou $100 par semaine. Le « max units » est de 1000%
pour dire qu’il y a dix employes. Noter aussi que le base calendar pour les employés
est de type « 24 hours ».

Le compresseur a un co(t d’utilisation de $500 (chaque fois qu’on veut I’utiliser pour
un travail) et colte $2,000 (std. Rate) pour I’extraction d’une tonne (material label).
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Affecter les ressources aux taches

Méthode 1 :
- Double cliquer sur la colonne « informations » d’une tache, puis aller dans la
section « ressources » :

Task Information 5]
General | Predecessors  Resources | Advanced | Wotes | Custom Fieds |
ame:  [preparation terrain Duration; [10d | T Estimated
Resources:
~
Resource Name Units
Ouvriers 300%
Compresseur stonne
Nasti M 355
i e
v

Dans I’exemple suivant : 3 ouvriers (300%) travaillent sur la tache «préparation
terrain », Nasri M supervise a 25% de son temps et le compresseur doit extraire
I’équivalent de 5 tonnes.

Méthode 2 :
- on peut aussi utiliser le bouton «assign resources » de la barre d’outils

(encercle) :
Edit Wew Insert Format Tools Project Qo\laborﬂrg Items  Window

dB[c 8V %0 )98 e 25 s A B ) | No Group
b — 4
@ - | Resources - | Track - | Report ~ !
% = & show- | Arid 8 x|B £ U|E]|= = AlTasks
se Team Project BRGet Work Iterns | FuUblish @ Refresh | !
3
preparation terrain
¥ Task hame Duration Start Finish Predecessors  Resource hMames
=l initiation 6 days Sat 41/06 Sat 4806
RV associes 14 Assi R E]
RV banue 1 551gN Resources
=l analyse 17 daj Task: preparation terrain
etude financiers T Resource [ist options 3
et ket
ude mareEting Resources From exl.mpp
» etude RH 10d

=l Production 26 d Compresseur L
B Resource Name R/D Units
fabricstion bonbans 20 d .

Compresseur 5 tonne
fabrication hoites Sddl | v st M Erry Remove

empacuetage Bdg | v | Ouvriers 300%
. - Replace...
preparation terrsin 10 i

vt |

Hald down Ctrl and click ko select multiple resources

L’ avantage de cette méthode, c’est que la fenétre « assign resources » reste visible et
on peut rapidement passer d’une tache a I’autre et répartir les ressources.
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Ajustement automatique du temps

11 empaguetage B days Sun BM06 Won BA 206 3,10
12| 1ei vr preparation terrain | 775 days | Sun 512108 Wied SI2406 105 Cuvriers[300%], Com

Yau changed resource units, The work can't be done in the current duration, Doy

Change the duration so resources spend only the specified hours/day warking on
O Change the task's total work (person-hours) to match the units and duration,

Show me more details,

En passant de 3 (300%) a 5 (500%) ouvriers pour la méme tache, le temps a
automatiguement été réduit de 2.25 jours, passant de 10 a 7.75 jours.

Project nous propose de garder la nouvelle valeur (change the duration) ou de garder
cette valeur (change the total work) au cas ou nous avons réalisé qu’il faut plus
d’effectifs pour réaliser cette tache dans le méme délai.

Ajout d’un codt fixe :
Afficher le tableau des codts : view > Table : Entry > Cost
Ajouter le colt fixe dans la colonne « fixed cost »

Codt variable pour un employe :

On suppose qu’on va augmenter ou réduire le salaire d’un employé a partir d’une
certaine date :

Dans le resource sheet, double cliquer sur la personne en question, ajouter des lignes
dans le tableau. Le calcul des codts se fera automatiquement dans MS Project.

Geerdl | Workig Tene Costs | omem | custmPess |
PRoesource Bame:  [uioc
ek rate bables
For rskes, srier & vahue or noresss or e Fer
iskars, 1 & vesource’s Per Usa Cost is revhied by 20%, by -20%.
Amelat) | B c o
Cifective Date  Standardiate | Owerbme Raste | Per Use Cost
450.00/h | $7500h $0.00
MenGiLie  |[$100.000 T |$0.00
Fri 81106 fzs.cc-'!. $35.00M [40.00
ot gronasl: [Procsted <
_ o | Otk | [ ok | cawd

Autre option, plusieurs tarifs selon le travail :
Utiliser les « tab sheets » A, B, C...E
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Pespurce Information X
Gerwed | werkeg Tiere Conts | Nkes | custom ek
Fiesource tome: [EI0E
Corst rote Lables
Fu e, cobos & vok cr 0 percontine o
ratance, f a rescurce’s Pes Use Cost i seduced by 207%, type <01%,
A (Defaur) B I & o [ |
Efiectio Date | Sorcwdate  Owertie Rt | Per Use Cot
- $250.00/w $300,001w $0.00
[
| P [

Appliquer des tarifs différents : aller sur view - task usage (ou utiliser le view bar),
double cliquer sur la personne sous la tache ou le tarif est différent et modifier

O |TaskName Work Apr 8,06
Detels F s s [ T w
1 |« B Technical reguirements co s0hs | iork
BIOC 4005 ark
Wac a0ms| yark
2 Sl Database desion anclimple. 24 10s| ek
sioc .
3 = Client feedback on databa: Assignment Information E\
moc General } Tracking | Hotes |
4 = Dstabase finslization
sioc Fhase 1-sample modules development
. Moo Resource: E=S
5 | B Deta Access Objects Imple
BIOC work: E = Urits: [
g =l Back Office Developme: 2 \work contour: | Flat =
7 =) Phase 1-sample mad.
= il Start: Mon Z(6/06 | Committed
8 = Client Feedback on de Einish: Fri 2/10/06 |
MocC Cost: $2,000,00 Costratetable:  [A
] £l Phase 2-Modules dev
aoe Cancel
10 = Client Feedback on de
war : : :

Dans la méme fenétre : work contour :

Flat : travail distribué également sur toute la longeur de la tache

Back Loaded : commence bas puis augmente progressivement

Front loaded : commence au maximum puis diminue progressivement

Double peak : 2 « sommets » : bas-haut-bat-haut-bas

Early peak : maximum durant le premier quart

Late peak : maximum durant le dernier quart

Bell : debut et fin au plus bas, maximum au milieu

Turtle : semblable a « Bell » sauf que le travail est plus élevé au début et a la
fin

Noter les symboles dans le tableau « task usage » :
o = lestng

il
al

T

BrOG
Moc

1 Fulos searsires @ T

Type de Taches :
Work=duration X units
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Task Information E‘

General | Prederessors | Resources advanced | Motes | Custom Fiekds |
Hame;  [Debugging & Tuning Duration: [5d :‘ ™ Estimated
Constrain task

Deadline: A |

Constraint type: [ s Soon As Possibls ~| Constraint date: [na |
Task bype: Fixed Units v | Effort driven

Fixsd Duration

Celencsl Fixed Urits Ju
WES code: Fixed Work

Eatned valus method: % Camplete -

™ Mark kask as milestane

- fixed unit task : par default, lorsqu’on ajoute des ressources, le temps est

affecté

- fixed duration : le temps reste constant méme si on ajoute des ressources. Dans
ce cas, si la tache est « effort driven », le % de travail est affecté (en doublant

les ressources, chacune travaille a 50%), sinon, tout reste inchangé.

- Fixed-work task : en ajoutant une ressource, le temps varie. En augmentant le

temps, les unités (%) diminuent.
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Réduction du nombre d’unités sur une période donnée :

source hame Type Material Label Initials Group Max.Unts | Std.Rete | Ovt.Rate | Cos
BIOC A00% | $50.00/hr | $75.00/hr

]
@ MOC Work M 100% |  $0.00hr | $0.00hr

General | working Tme | @i | Notes | customFields |
Resourcepame:  [BI2C kel e
Email: —  com —
warkgroup: [oefa 7] coder —

windows fccount., | [ Type ,ﬁ
Bocking type: [commies ] —
I~ Generic
Resource fvalabity
-
Avallable From | Avalable To |Unis
‘ 0.
v
Help Detib... | oK Gl

Gestion des ressources (conflits / overallocation)

- ouvrir le « resource usage »

- les personnes qui sont en « overallocation » apparaissent en rouge

- afficher la barre d’outils « resource management »: view -> toolbars —->
resource management

i | 8 | 98 | New Resource From -~ | B W5 &L | #f &d | 7 | g !

- clicker sur le bouton «resource allocation» pour voir dans un table

1

I’utilisation des resources

- pour voir rapidement a quel niveau (jour) on a un probléme, cliquer sur « next
. | i |
overallocation » ==

A ce niveau, on peut, ou bien gérer le probleme manuellement ou automatiquement :

- noter tout d’abord la date de fin du projet (project > project information ->
statistics)

- ouvrir le tableau « leveling gant » a partir de « more views »

- dans le menu, tools - level resources

- noter les deux graphes superposés (original et « leveled »)

- noter aussi que le résultat du « leveling » n’est pas toujours parfait et que, dans
beaucoup de cas, il faut procéder a des ajustements manuels.

Pour résoudre manuellement une « overallocation » :
- ajouter ou diminuer les ressources sur des taches specifiques
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- changer la date d’une tache (eventuellement en ajoutant des contraintes « start

no earlier than »)

- découper (split) une tache en plusieurs « morceaux »

- ajouter des heures de travail «overtime» en utilisant le calendrier des
ressources travaillant sur la tache en question

Tracking

1- Définir la baseline > project > set baseline (up to 10 baselines) > entire project
2- choisir la tache puis task > mark on track > mark on track = accompli dans les

délais prévus

3- sinon task > mark on track > update task — soit date début, fin — soit pourcentage,

durée utilisée, durée restante

4- view > table > tracking pour travail accompli, cout, etc.

Act.

Phys. %

Act.

Rem.

Act,

Act.

Task Name + | Act.5tart » Finish ~ Comp~ Comp. - Dur. + Dur. ¥ Cost ~ Work ~ Addl
1 |4 Lancement du pr /ed 1/10/14 lve 7/10/14  100% 0% Sdays Odays 55,100.00 64 hrs
2 RV associes |!ed 1/10/14 Thu 2/10/14  100% 0% 2days Odays $2,500.00 32 hrs
3 RV bangque sun 5/10/14 rue 7/10/14 100% 0% 2 days 0days $2,600.00 32 hrs
4 |a Analyse fed 8/10/14 NA 27% 0% .76 days 8.24days 55,000.00 &0 hrs
5 etude financie /ed 8/10/14 e 14/10/14  100% 0% Sdays Odays $4,000.00 40 hrs
6 etude marketi 2d 15/10/14 MNA 42% 0% 1wk l4wks 51,000.00 20 hrs
7 recrutement NA NA 0% 0% Odays 20days $0.00 0 hrs
8 Debut des MNA NA 0% 0% Odays  Odays 50.00 0hrs
operations
5 | 4 Production NA NA 0% 0% Odays 11 days 50.00 Ohrs
10 produit NA NA 0% 0% Odays 10days $0.00 Ohrs
n emballage NA NA 0% 0% Odays  S5days $0.00 0 hrs
12 livraison MNA NA 0% 0% 0 days 1day 50.00 0hrs

4- tracking gantt pour vue générale
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GANTT CHARTTO0LS  MS-Project-1-2015-resources.mpp - Project Prafessional P =

Tasx Rﬁﬁﬁti xwiin PROJECT \-ﬁv ‘ﬁﬂ FORMAT Masri Messaira = x
—_F::h'!hwl hagram * = [ Fesounce sage - # ! %5 Highlight: |[No Highbght] +  Timescale # Timekne | Tameline i = | Bl
I 7 i} - - b

= = - [y W= =
= B Calendar - “Sae % Resouce Sheet - = i Wrmer  |INoFikerl - [8)Days - Q e S| Dexails g -
sk o Team & Sert Outhne Tables - - Zoom Entire Selected Mew . Macres
Chart= Usage - 22 Other Views - Pranner= T8 Other Views « - - - T Group by [NoGrowp] - = Prject Tasks Window -
Task Views Resauree Views Data Toam Spin View Winsow Magres
z |50t 14 |12 0ct 14 (1o 14 (26014 |2 Hov 14 (5o 14 |16 Now 14 (23 Now 14 30 ov 14
b Start A e e b ook P 1 Finish
z Wi T | Add tasks with dates 1o the timefine Wed Vs
Al ug 1 o Ot *
Add Ne & .
2
3 |mg R b.mqn;-m Tsun3/10/14 Tue 7/10/14  Mon3/10/15  Tue 8/10/15 260 days. mud.-y-\
- * Analyse Ned BA0/14 fue 11/11/18 Wed 710015 Thu 12/11/15 260 days 262 days _—1%
- etude financic Med 8/10/14 "ue 14/10/18 Wed 7/10/15 Thu 15/10/15 -260days -262 days — 100%
5 - etude marketi fed 15/10/24 hu 30/10/14  Fri 16/10/15  Thu 29/10/15 -262days -260 days [— 2%
- recrutement  fed 15/10/14 "ue 1110714 Fri 16/10/15 Thu 12/11/15 -262 days -262 days Mo (0%
- Debut des ope 'we 11/11/14 ue 1L/11/14  Thu 12/11/15 Thul2/11/15 -2620ays -262 days o'tlm
G - 4 Production fed 19/11/14 Ned 3/12/14  Fri 20/11/15  Friaf12/15 -262days -262 days %
F oW o produit led 19/11/14 Tue 2/12/14  Fri20f10/15 Thu3/12/15 -262days -262days 0%
g L emballage  fed 26/10/14 Tue /13014  Fri27/10/15 Thu 31315 -262days -262 days 0%
g @ .,y Tivratsan Ned 31214 Med 3/12/14  Fri4f1/15  Fri4/12/15 -262days -262days To%
2

View table cost > add column > baseline

Mettre a jour en fonction de la réalité :
- choisir une tache et task > mark on track > update tasks. Mettre les valeurs
« actual ».

lUpdate Tasks [‘5_<|

Marne: |Design requesks | Duration:
% Complete: | 0% & Ackoal dur: Remaining dur; | 5d =

Actual Current |
Start:  |MA “| St Fri117j08 | L
Finish: | w|  Finish: | Thu 11/13/08 |

[ Motes... ] [ Ok ] [ Cancel: -]J“

Pour les taches termines, Project place un « check mark » dans la colonne
« informations » :
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o Tazk Mame Cuiration
y : I [iesinn rem est I g5 WE
& This task was completed on Thu v
5/19109,
TTOOCCT Sl ST T T o Ty E

On peut aussi utiliser la barre d’outils « tracking » pour mettre a jour rapidement le
pourcentage de la tache effectué :

& mi © 0¥ 25% S04 TSH 100%
A | R i 2R

- La premiére icbne donne acceés aux statistiques (comparaison conception,
actuel).

-« update as scheduled » marque le travail comme terminé. Elle nous permet
aussi d’obtenir le pourcentage du travail effectué au cas ou la date du jour est
antérieure a la date de fin de tache.

-« reschedule » essaie de résoudre les problemes de suremploi

-« add progress line » place une ligne pour montrer le progres effectué. On peut
placer plusieurs lignes. Pour les enlever faire un « right click » sur le c6té du
graphe.

- Les pourcentages marquent le travail effectué (en pourcentage)

-« update task » ouvre la fenétre de mise a jour du travail effectué

- pour les taches partiellement terminées :
o0 dans le task usage view, choisir format - details - actual work
0 mettre le temps de travail réel
0 noter que le temps est automatiqguement modifié en fonction de votre
« input »

Mise a jour des codts

Normalement, Project calcule les codts automatiqguement. Sinon, on peut le faire
manuellement en faisant Tools - options - calculation et en éliminant I’option
automatique :
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Options
Views General Edit
Save Interface Security
schedule Calculation I Speling
Calculation options For Microsoft OFfice Projsct
Calculation mode: © Automatic O Manual
Calculate: () Al open projects ) Active project

Calculation options For "timeplan_tracking, mpp'
[#]Updating task status updates resource status
[IMaove end of complstad parts after skatus dake back to status date

Earned ¥alue. ..

[JEdits to total task % complete will be spread to the status date
[#] nserted projects are calculated like summary tasks
[#] Actual costs are always calculated by Microsoft Office Project:

Default Fixed costs accrual: | Prorated ~
[ calculate multiple critical paths

Tasks are critical i dackis less thanor equalto |0 £ days

[“IMove start of remaining parts before status date Forward ko status date

|

Calendar

Collaborate

Caleulats Now

Set as Default

| Cancel

|
|

Ensuite passer sur « view -> task usage » puis « view - table = tracking » et enfin
sur « format - details - actual cost »

Noter qu’on peut accéder a la derniére option par un right click sur le tableau jaune et

gris.

view - table - tracking
view - toolbars = tracking
utiliser les boutons « % »

O 00O

Comparer la réaliteé a la conception:
voir le « tracking gantt chart » et la comparaison entre réalité (en couleur) et

I’estimation (baseline / gris)

on peut aussi utiliser le pourcentage view - more views - task sheet
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Aide mémoire fonctions de base

[EEN
1

N
1

w
1

(@2 BN N
1 1

(o)
1

10-

11-

12-

13-

14-

15-

16-

Créer un nouveau projet — définir la date du déclenchement (début) ou de la
fin:File 2> New

Définir les détails du projet: File > Properties (permet aussi de voir
les détails : colts, suivi, etc. du projet ultérieurement)

Définir les jours de travail, vacances, horaires: Tools -> Change
working time. Le bouton «options » permet de changer I’horaire par
défaut (Note : chaque ressource, employé ou machine, peut avoir un horaire
spécial différent).

Définir les taches automatiquement

Utiliser le Gantt Chart et saisir les informations dans le
tableau de gauche. Ladurée peut étre en heures (h), jours (d), semaines
(w) ou mois (m). Par exemple, 0.5h ou 3w

Différence entre jours ouvrables (d) et semaine (wk =5 jours + week-end)
Types de prédécesseurs: FS, FF, SS

Définir un décalage entre deux taches liées (ajouter un temps mort ou
démarrer une tache avant que la précédente ne se termine): Double
cliquer la relation et changer le lag time (temps mort).
Utiliser une valeur négative pour un démarrage anticipé. On peut aussi utiliser
des pourcentages (-50%).

Ajouter une note a une tache: bouton droit -> task notes ou
utiliser le bouton « sticky notes » sur la barre d’outils.

Note : en faisant défiler le tableau de droite a gauche (scrollbar en
dessous du tableau), on peut voir la date de départ et la date
d’achevement de chaque tache.

Taches répetitives : Insert > Recurring task

Tache sur plusieurs périodes : utiliser Edit - Split Task puis travailler
graphiquement dans le tableau Gantt.

Note : une tache peut étre déplacée par les fonctions copier — coller — couper
(edit - copy,edit - cutetedit > paste).

Note : on peut insérer une ligne grace a Insert > New Task.

Créer une borne (Milestone) : la méthode la plus simple consiste a créer
une tache dont la durée est de O jours. On peut aussi faire un double click
sur la tache, puis advanced, puis mark as milestone.

Deadline
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17- Constraints
18- Fixed costs / View table entry / costs

19- Sous-Taches : utiliser les options Indent (aussi appelées demote et promote)
dans labarre d”outils (fleche vers la gauche et fleche vers la droite).

20- Relier les taches (précédence) : la méthode la plus simple consiste a cliquer
au centre de la premiére et a enlever le doigt au
début de la seconde. Une autre méthode consiste a selectionner les
deux t&ches dans le tableau et a cliquer sur I’icéne représentant une chaine
dans la barre d’outils.

21- Délier les taches: double cliquer sur la fléche qui relie
les taches et choisir Delete. Sinon, cliquer sur la premiere tache
et utiliser I’icone représentant une chaine brisée sur la barre d’outils.

22- Commencer et terminer une tache a des dates spécifiques: Déplacer
graphiquement la téache ou double-cliquer sur la tache et utiliser la
fenétre Task Info.

23- Assigner les ressources : Dans la View Bar (a droite, en dessous de Gantt
Chart, choisir Ressource Sheet), puis s’assurer que View - Table
- Entry est sélectionné. Introduire le nom, maximum units (on peut par
exemple mettre 50% si la personne travaille & mi-temps), standard rate et
overtime rate, cost/use (usage supplémentaire a [I’utilisation), Accrue
(facturation), Base calendar (on peut définir des heures de travail spécifiques
pour chaque ressource).

24- Définir les ressources de chaque tache: double cliquer la tache
puis resources et remplir le tableau avec le pourcentage de travail
assigné a la ressource (100% signifie que la personne va consacrer tout son
temps pour cette tache).

25-Voir lutilisation des ressources: dans le View Bar, choisir
Ressource Usage.

26- Voir le codt des ressources : étape 18 puis View - Table - Cost.

27- Graphe des ressources : choisir, dans le View Bar, Resource Graph.
Utiliser le bouton droit de la souris sur la zone de la
ressource pour passer a la ressource suivante et le bouton droit de
la souris sur le graphe pour changer de graphe : colt, travail, etc.

28- Changer la forme du Gantt Chart : la méthode la plus simple consiste a utiliser
I’assistant (baguette magique sur Hla barre d’outil). La
méthode manuelle consiste a double cliquer sur les taches dans la zone du
graphe. Utiliser cet assistant pour retrouver le chemin critique.
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29- Mise en page: Utiliser File > Page Setup et File - Print
Preview. Pour I’affichage, ont peut utiliser les Views et le Zoom In / Zoom
Out. Aussi, pour imprimer la page affichée, cliquer sur I’icéne Imprimante sur
I’écran.

30- Dépendances : double cliquer sur la relation (Finish to Start,
Start to Start, etc.).

31- Sauvegarder le projet de base (baseline) et le suivi du projet (jusqu’a 10) :
Tools > Tracking -> Save Baseline ou Save Intermim
Plan.

32- Ajuster selon la réalité : choisir la tache, tools = tracking. Mettre la date réelle
de fin de tache ou le pourcentage terminé.

33- Comparer avec le projet de base : utiliser l’assistant ou view -
table tracking.
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